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Test Booklet / GR1&T QfEIHT
This booklet contains 24 pages./ g gffE A 2405 7|

Test Booklet | Test Booklet Series|  Test Bookiet No.

T gt Wy i | ol gt gaw | DO Mot open this Test Bookdet until you are asked to do so.
= T oy gt 3 aa aF 1 Eid o 9 ST 9 |

PAPER-A A-A 101108041 | Read carefully the instructions on the back cover of this boaklet.

W Wy o ¥ el s RrRds f ardwd |

Allowed Time : 90 Minutes
e 5o : 90 fiFe

Maximum Marks : 100
Hftrean 3 : 100

1. The OMA Answer Sheet is inside this Test Bookiet. When you are
directed, open the top seal of Test Booklet, take out the Answer Sheet
and fill in the particulars canefully with black ball point pen only.

The test is of 90 minutes durstion snd conslsts of 100 objective type f

answer. Negative

1 TTHA

questions. Each question carries 1 mark for

correct
Aariing 5 0

. lise Biack Ball Point Pen only for writing particulars on this page and
marking responses in the Answer Sheet.

. Make sure that the Test Booklet No. and Serles marked by you on the
Anvwer Sheet 5 the same as that on this Booklet.

. Rough wark should be done only In the space provided In the Test
Bookhet

. The answers are to be recorded on the OMR Answer Sheet only. Mark
your responses carefully. No whitener/ eraser / Blade is allawed for
changing answers.

.+ After opening the Test Booklet, please immiediately &nsure that no page
or guestion s mlsprintad, torn ar keft blank. If any discrepancy s found
In test booklet, show it to |nvigilator and get it reploced with test
booklet of sama serles,

. For any questian |f thare s any discrepancy in Hindl or Engllsh language
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PSG1
fad 1¢ i @ IuR W 99w S |

1—4 T @ SN Qg

T 7 FPRM WGEE B PR TS
1% B v fRar| 9= wo-ue B

Y HYAT YRR THEE B gy A

IE g a8 W | W I A g
A sgar et B S8 s
e A I FRG AR I ofy
- & fow @ s R us
FgEaT 99 a9 farar oY 9 @e
& S §Q O & T g A | T
T WERE & & ¥ e 3w 9
& oY 1o | i g ey S9 fierr
T WA 14 7§ af-f B T
B Y& T T8 I T | e B

e B & R S dxeEE ok

S @ faga gE-wdw ® gl
a1 fean S/ & forg siaet anfR #f
@ TR A gRger!

AT AW & AW o & fog ot
g7

A. JwEE A Har & g

B. foem & amsm & @)

C. 9§ & A aegfls O & wro|
D. S q [ oH & g

AEE B T W 87
A. TR WE-UTE BIGHR IR 6
LG

B. &qT W W1E W F WY g B

ECR
C. St & wenu | fagrr 8 )
D. Rt A Sfifen & fawg % oo
8 foran |

3. Sffen 5w sfemE 76 A
A. o g faame v
B. 39+l 984 ¥an &1 faahr wan|
C. W& B! N & G 99419 &
fog v e
D. |iERe g@&f &1 e |

4. IEN I GRS G9 & N D
3 | T &Y ST g 9RE N AuD
o1 a1 ared & 7
A, Sffen a1 AN IER © T R @
a8 e

B. Sfifet &I TEga Hufy ¥ 9 %
UG B AT HET G |

C. 3fier &) IR 75 we 5 R
®I TET & 99|

D. 7€ faaE & Ao & W& ofe T8
g |

5. NN H A W EIE 8 7
A. THERY G

B. TWegwY HHTH
C. =g |HrY

D. sgAfE s

6. frafolet Fea-aem gt i A =
P adt 2 ?
A. IRP-IEF
B. IE—aAR
C. I—3r

D. 399T—-HATH

7. ‘garfda W & o9 8 7
A. &S B. wg§
C. B D. g

| 8. =N R 3R A IE IR I W

A, 3wy B. sfgam
C. &= D. wg®

10110804103 3
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9. v W & fow oftg vafg o g 15, Prefafea @i # @ w3 g @
_ ; qEaE Sy |
| B =R A o= 8 @ A S e T
&l B. < < @1 vA v &
A. fEmE B. ™ C. ™ 39 yfsms &1 Sivg & fb adem
C. ©Y D. UHs ¥ o= oF W T |
D. o9 ¥l 99 @ @) T g0
10, Presferee % % e v arer v T | SR B
71 3f e 2 16. PrfeiRed % ¥ el geraR @1 ot afaT
A. ¥ B. ¥ BFTel 27
A. 9F—OREY B
e ™ o B. SO J§ AIR B A
C. TH—H J8 xR B
11. g faem gm &1 =97 i) D. ﬁgﬁwﬁm
A, FFI-aR B, Uiy
C. FG—ah D. o—dfys IT.W%%WEﬁTﬁ#W
T I3V |
A. o9, B T, @ )
12. Y€ 9O WHE &7 949 a | B. Su—g aER-T, T &
A. IRfEdaAfeH famas YaEl §)
B. 3R feaam C. @7 39 YeAT & &1 are &7
D. dmE! w7 e, TR A5
C. TR S GTa r:r:aﬁ@fﬁﬁ ggd
D. gy, g
18. ‘@mEm Fax I A &1 F
13. fr=fafes gt & fov v e & aef 27
¥ o w1 g T ¥ A. ¥ A BT wEs |
A5 T & TR & — o = gﬁgﬁ”
B. v o T W W@ — dgw D. §HF Sat & B
C. & anfey =& @mn — aifaw o .
D. @ T — 19. foher AeT 7 T B
bl A. gl B. el
C. f&d D. 9§
14. fFr=fefea w=i § ¥ Eiferr o= difen
A. TTorer B. v 20. f=faRaa & ¥ &9 W1 ad9= 19 &1
C. T D. 7vfy g 5] 87
A. TS gdEE
B. QU aaRE
C. wfe aaw=
D, BIRGHT T
PA/AA 10110804104
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21. Which of the following words can be | 21. ¥4 ¥ %1 O Vi€ Bael EEELLPSS

formed using all of the letters JERT T HAWT TR TG o Gl & 7
EEELLPSSS, but none other?
A. STEEPLESS A. STEEPLESS
B. SPELLSETS B. SPELLSETS
C. SLEEPLESS C. SLEEPLESS
D. EPISTLES D. EPISTLES

22. Three of the following four letter-  22. &1 9R 3R — &l ¥ ¥ 49 f&@
clusters are alike in a certain way and HHR & THM £ 3R Uh F6ad 2|
one is different. Pick the odd one out. T @ fafea &Y
A. CHSX B. IKPR A, CHSX B. IKPR
C. DIQW D. AFWZ C. DIQW D. AFWZ

23. Selectthe letter-clusterthatcanreplace | 23. a8 3eR—u9g 9+ W Fr=ifaiRaa si@en
the question mark (?) in the following ¥ weq — RR(?) &1 wnA o aear £
series. LJB, NIY, PHV, RGS, TFP ?

LJB, N1Y, PHV, RGS, TFP, ? -
A. VEM B. VEN A. VEM B. VEN
C. WEM D. VFM C. WEM D. VEM

24. If DAMSEL is coded as AEDLMS, 24, af@ DAMSEL %' AEDLMS & 9 ¥

how will VALOUR be coded as? Tieag fdar mar 8, af VALOUR &
g war Feag B smon?

A. AUVROL B. AOULRV A. AUVROL B. AOULRV

C. AVUROL D. AROUVL C. AVUROL D. AROUVL

25. Select the option in which the numbers | 25. 78 faweq g+ forad Wt o0 woR
are related in the same way as are the e # we & o Ry 7T g W
numbers in the given sets, i Hean wefaa ¥
(6, 15, 30) and (12, 14, 84) (6., 15,30) 3 (12, 14, 84)

A (12,16,32) B. (16,12,36) A. (12,16,32) B. (16,12, 36)
C. (12,16,48) D. (16,12,72) C. (12,16,48) D. (16,12,72)

26. Selecttheoptionin whichthe numbers 26, 98 Rwey g+ Ryt Hed S R
are related in the same way as are the o A Heed § o RY g g A
numbers in the given pair. e e & |
(7.343) (7, 343)

A. (5,125) B. (4.16) A. (5,125) B. (4,16)
C. (3,81) D. (25,125) C. (3, 81) D. (25,125
10110804105 PA/AA
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27. If oats are called carrots, carrots are 27, X W DI MR FeT A1 8, TR B
called blimps, blimps are called flowers, fecrvag Pe1 T 2, oo @1 G Pel
flowers are called stones, stones are T 8, A B GRR HEl Tl % qeeR
called balloons and balloons are called B [ERT HET W & AR [ER @
toys, then what do buds bloom into? el wer o 8, o wferdf Rawaw

& g 87
A. Flowers B. Balloons A, e B.
C. Stones D. Toys C. &R D. %

28. Select the option in which the letter- | 28. @€ faweu T o FER—WE 9 WPN
cluster is related in the same way as is T ¥ Hemd & o R o see—wgg
the letter-cluster in the given set. Hafda &1
JNQS JNQS
A. FIMP B. PTWY A. FIMP B. PTWY
C. NQTV D. DHKN C. NQTV D. DHKN

29. Which of the following strings of letters 29, fy=foied & 4 9 R s@en =
can be prefixed to the strings (IGHT), S@e (IGHT), (AME), (EW) 3R (AT)
(AME), (EW) and (AT) to make 3§ Uge M W WA T T G
common words that can be found in et ol sredy ® U1y o e 87
an English dictionary?

A. (BR) B. (SH) A. (BR) B. (SH)
C. (PL) D. (FL) E [PE) D. (FL)

30. In alanguage, 'mohu rupt nyrk' means 30. us wmr %, ‘mohu rupt nyrk’ @1 3rf

'‘intelligent and hardworking', ‘'mohu triv W 3R gAY, ‘mohu triv _]ECh
jech' means 'tests and examinations', #1 3w} g aik wdend, jech lyge
'‘jech lyge' means 'examination #1 aet ofEr ge 8l ‘stoj rupt’ &
questions’ and 'stoj rupt' means o A
'intelligent answers'. What will be the ::3 i mﬁﬁ%%g?ﬁ?ﬂ o
expression that means 'questions and '
answers'? )
A. mohu lyge stoj A. mohu lyge stoj
B. nyrk rupt mohu B. nyrk rupt mohu
C. nyrk mohu triv C. nyrk mohu triv
D. stoj nyrk rupt D. stoj nyrk rupt

31. Select the correct mirror image of the | 31. 23 Wy W &7 Wl 20 affda g

given combination. o
WIETALS METALS
A GJETTEM B, MEUALE A GARUTEM . WERTAIR
C @JarEm P elLAren C. 2JATEM °- GLATEIM
PA/AA 101108041086
AN RN HR IO
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32. Suman leaves her home, turns left, | 32 A ) ¥ fAwen, a8 78 I
walks 300m towards the north and %q;f*ﬁ 300m g 3R FEE m?g N Ccia)
reaches the Mahatma Gandhi junction. =

; vga ¥ @ ¥, 97 TR IR T alR
From there, she turns right and walks
500m to reach a hospital to visit an @ R 7 @ e 3 fom so00m
ailing friend. After that, she turns right THY IV GEH | T AT, TE A
to go to a supermarket. After shopping HEHR UF FE | g
from the supermarket, she walks e $ a1, 98 W TAPT A
does the road from the Mahatma T A wSF g R F e 22
Gandhi junction to the hospital run? ~ :
A. EasttoWest B.North to South A FHuRE B, IR A R
C. South to North D.West to East C. ford o D ufem § @

33. Three of the following four optionsare | 33. ¥ aR faweul § & f7 5 R 9
alike in a certain way and one is different. I & 3R Ua s ¥ eI @
Pick the odd one out. farfaer ¥ |
A O, B ) A 9 B &

o H® RO y E® C [
of T D. 0 C 0, D O
® [=]® BNEO) O,

34. Select the option in which the terms = 34 ag fsey % o vl & fra 28 v &
share the same relationship as that < 23 ¢ ug g @ 4 B
shared by the given pair of terms. ath 4
Square : 4
A. Decagon :5 B. Pentagon:9 A, SI9d 5 B.98& : 9
C. Hexagon :7 D. Octagon : 8 C. ¥eqa1 : 7 D.I<qw : 8

35. Select the option in which the words 35, @8 ey T R vt & 4w of
share the same relationship as that ey & 9 34 T v g B 9w R
shared by the given pair of words. BT fehre
Paper : Book
A. Phone:Talk B. Wheel:Car A. ©F : 9t B. ufedn : &R
C. Metal:Coin  D. Loan : Interest C. oy : o D. 3 : =TSt

36. Select the number that can replace the | 36. 9 W@ g W Fr=foRaa At % v
question mark (?) in the following series. foR (7) & ©F o W&l 81
512,768, 1152, 1728, 7 512,768, 1152, 1728, 7
A. 2888 B. 2172 A. 2888 B. 2172
C. 2482 D. 2592 C. 2482 D. 2592

10110804107 PA/AA
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40.

¥

39.

Select the number that can replace the
question mark (?) in the following
series.

511,255, 7,63,31, 15,7
A, 124 B. 127
C. 175 D. 125

. Three of the following four options are

alike in & certain way and one is different.

Pick the odd one out.

A. @@ B. E,@
O

© e P EE

Which of the options would be the sixth
figure in the following series?

Ci|le H||IL M| RV W
a F k P u
o (|0 N||T S| Y X
L] 2 3 4 5
A B A
A T B. z
c
A B D C
z D x
C. b C ) A B

Select the fraction that can replace the
question mark (?) in the following
series.

643216 8 4,

9 '27°817243° 729"

2

3.

38.

39.

440.

qg e g1 o Ffafaa sdf F as
e (7) &1 W@ o A B
511, 255,7,63,31,15,7

A 124 B. 127
C. 175 D. 125

T IR ol # ¥ T4 50 voR |
A & IR = sme ®) e @
fafeaT &1

®
A. E@ B. E]@
2 9, D 0
' C[e®
& TS sige W B3 W W PN A1 fAwed
3T 7
S
A I.lzB B F 4
A B o c
C. nz'.: D. nll

g8 =1 g o Fvafafea st 3 wem
fore (?) &1 w—nw o "Har 8|

64 1216 8 4

2 I

T B o A 5w B. &7

K 2 4 &

C. 159 D. 2187 C. 1539 D. 2187
PA/AA 10110804108
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4]. The famous historical monument
'‘Buland Darwaza', built by Akbar, is
situated in the district of
Uttar Pradesh.

A. Meerut

B.
C. Agm
D. Allahabad (Prayagraj)
42, Which Sikh Guru's birth anniversary is
celebrated as the festival 'Gurupurab'?
Guru Gobind Singh
Guru Tegh Bahadur
Guru Arjan Dev
Guru Nanak Dev

COwp

43. Which of the following folk dance
forms is NOT associated with the state

of Haryana?
A. Dhamal B. Khona
C. Jhumar D. Jawara

44. Which of the following banks is NOT

a public sector bank in India?
A. Allahabad Bank
B. Punjab National Bank

l C. UCO Bank

i D. Federal Bank 1.td,

45. Which scheme was launched by the

4].

43,

45,

IBaR GRT ST T4 g YReie
RS ‘el SaaT SR AR B ——
— oy 3 ey 2

A. g

B. &MY
C. ImRI

D. gieER fRrR)

. fou R 5 & o TewE ER

SO H A o g ?
A. TS M s
B. % O 9E8IgY
C. % 3 &9
D. T % a9

T A P ARG SR I
Hafa = & ?

A. =T B. @fRar
C. W D. WaRT

ARA H 30 A DI 1 ¥ Adulfrs 8
o e ?

A. SOEETg 4%
B. G99H W9 95

C. @ ¥
D. %&vd §

2015 ¥ vEFEEAT gRT R — FuRe, I’

Prime Minister in 2015 for providing P Y /GeR STA DY 10 T AD B

loans up to 10 lakh to non-corporate, F WS HE @ g T | I W

non-farm small/micro enterprises? AT g6 D g A 7

A. Pradhan Mantri MUDRA Yojana A. SR 9RT Ao

B. Makein India B. #% 3 3w

C. Uijjwal Bharat Yojana C. Fwadl AR T

D. Atal Pension Yojana D. &ca Y9 Ao
MR RavAA
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47.

49,

Which of the following Commissions
is mandated to recommend the
minimum support price for farmers?

~ A, Commission for Welfare of

Farmers

B. Commission for Agricultural Costs
and Prices

C. Commission for Agriculture
Growth

D. Commission for Agricultural
Development and Growth

Prime Minister Narendra Modi launched
the Fit India Movement in the month of

2019.
A. July B. September
C. October D. August
Who among the following developed
the Theory of Relativity?
A. Madame Curie
B. Albert Einstein
C. Alfred Nobel
D. Charles Darwin

In October 2019, the Ministry of
Environment, Forest and Climate
Change (MoEFCC) launched the first
national protocol to enumerate the
population of which of the following
elusive and endangered species in India?

47.

48,

49,

g 9 few s A e & fag
S TR I iR ween Afar

FART & 7

A. f&am wegmr smam

B. & aF/a Ta Fwa aman

C. i gfg amr

D. 3 fawr e gig smam
WA g #ey 3 ————— 2019 W
fbe i q@iic # yooma i ot

A. TeTs
C. IR

B. fidsR
D. 3

ArerT o1 Regia (@ard it RafeRd)
0 9 fbus grr wfe aifea fasar
o ?

A. e /8 311

B. 3icsc IR 3

. TR SIfE &1

afeRvT, g G§ Aodrg aRad HATed
(MoEFCC) ¥ Jree@y 2019 # W= 4
gl @ fbe gor iR qRma womfe @t
&I H T BRY BT UEA T
WrepTer e fasaT e ?

A. Snow leopard A. fen dgan
B. Indian rhinoceros B. AR Aer
C. Gujaratlion C. ToRId & fie
D. Bengal tiger D. ¥7d TR
PA/AA 10 10110804110
C LT O
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10110804411
50. In which year was the River Ganga ! 50. fw ad F 7 =) & w5 98 Of¥a
declared a national river? | foar am o ?
A. 2004 B. 2008 A. 2004 % B. 2008%
C. 2014 D. 2016 C. 2014% D. 20l6%
51. Which of the following states are | 51. 79 9 &9 § U YTorElE g A 3GH
connected by the Palghat Gap? AEEUE?
A. Maharashtra and Goa A. TBRT AR Tar
B. Keralaand Tamil Nadu B. &% iR afeerg
C. Tamil Nadu and Andhra Pradesh C. afierg iR s s
D. Kamataka and Kerala D. &ics 3R &
52. Whichof the following Harappancities 52, ESW@ &I 379 o &9 W TR, 44
was divided into three parts? At ¥ fawfer om ?
A. Lothal B. Mohenjodaro (A) R (B) #rEar g
C. Kalibanga  D. Dholavira (C) BIetET (D) SrATERT
53. In which year was the Supreme Court | 53. % $fear ool 3 frg af & &eroa
set up by the East India Company in # Hdteg RTAY B WG 3 e ?
Calcutta?
A. 1757 B. 1765 A. 1757% B. 17654
C. 1773 D. 1792 C. 1773#% D. 1792%
54. In2019, who took the oath as the Chief ~ 54. 2019 ¥, fum sRan & e &
Minister of Haryana for the second w9 H g 9RO w ?
time? -
A. Bhupinder Singh Hooda A, ifter fe gg1 A
B. AnilVij B. et faor =
C. Manohar Lal Khattar C. ¥R o @EX A
D. Dushyant Chautala D. g&d demen
55. Who was awarded the Nobel Prize in ~ 55. 2019 # |ii2cd &1 F14e JWHR g4
Literature in 2019? A & e far mar ?
A. Abiy Ahmed A. ¥l IEAE BT
B. Peter Handke B. diex &=a &1
C. Olga Tokarczuk C. I APRIDE B
D. Bob Dylan D. sfa e &
10110804111 11 PA/AA
LT ML
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10110804112

56.

57.

58.

59.

The Indian cricket team played its first
ever day-night test match against _____
from 22 1o 26™ November 2019.

A. SriLanka B. England

C. SouthAfrica D. Bangladesh

Who won the US Open Men's Singles
title in 20197

A. Rafael Nadal

B. Daniil Medvedev

C. Andy Murray

D. Nick Kyrgios

Who was the Chairman of Indian Space
Research Orguanization (ISRO)} when
ISRO launched Chandrayaan 2
mission?

A. Dr K. Sivan

B. A.S.Kiran Kumar

C. Shailesh Nayak

D. K. Radhakrishnan

How many {undamental duties were
included in the Indian Constitution
through the 42™ Constitutional
Amendment?

A 11 B. 9

C. 10 D. 12

Under which writ does the court order
a lower court or another authority to
transfer a matter pending before it, 1o
the higher authority or court?

36.

57.

58.

59.

60.

22 q 26 94 2019 O& M fhee
W | 9T GEH JE -3 e

g & fawg Qe
A. A B. gwie
C. <f@wr anfleer D, 9ivERy

2019 3 Y UH. 3T Y69 vahe e
faam Sfrr?

. NIEA FFrel |

. Fe gET A

. @@ WA

. e fHforma A

@ >

o

sWX (ISRO) BRT Tg 2 fAem &g
féhy S & T Wiy 3R T
oA (ISRO) & armel oF & ?

. &. Raa

T o R HR

. I THE

. B, THHEH

42 9 Hfdgr GeEE &AM | IRAG™
dfers # fhoq Aifos wder aftafaa
fsd g & ?

o0®»

A. 11
C. 10 D.

B. 9
12

fog aifeer @& ol e, aER
e A1 fah o wifder) & wwer
difaq fady aviel &1 =W Wit ar
T ¥ WEiaRa $A 1 e
odr 87

A. Mandamus B. QuoWarranto A. TEH[ST B. JR&R gt
C. Certiorani D. Prohibition C. I3yoT D. sy
PA/AA 12 10110804112
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61. The second generation of computers | 61. SIS & T W
were based on X menfRa o |
A. integrated circuits A. TP oftwt
B. transistors B. WeI®Y
C. VLSI chips C. VLSI fuey
D. vacuum tubes D. fRdwer Aferemsit

62. Which one of the following input = 62. & % @af & wwfRg w1 & faw

technologies do banks use to process s fPfoites & & oW & Flfe
cheques? AHAIG & JGT PR E 7

A. OCR A. 31 9 IR (OCR) &1

B. MICR . B. W 31g. . 3R, (MICR) &1
C. OMR | C. 3. w4. IR, (OMR) @

D. Pixels D. faedew @

63. In the context of computer processors, 63, PR TaES ¥ Waw ¥, ALU @ qui

L what is the full form of ALU? WY R T 8 ?
| A. Arithmetic Logic Unit A. WReR® iR gfe
| B. Array Logic Unit B. W wifvw e
| C. Application Layer Unit C. Teihe AR g
’ D. Application Layer Usability D. TN o gufaferd)
|
| 64. Which one of the following is NOT an |  64. f=fofe % ¥ 7 v& wioH =5 @
. Object Oriented or Object Based N SETRa e (i) s
r Programming Language? e
: A. Perl A. Td
[ B. Ruby B. &
C. Python C. 9EH
. D. C D. C
l
l
el ; PR
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65. Which of the following binary  65. f=foRea 3§ & o= o7 fgemmd dibar
operations would give 101011 as the oo w9 101011 AT P(3E 9y A
result? (all numbers in this question are Y deEd fgamard T yuel 7 €)
in binary number system)

A, 100010+ 11001 A. 100010+ 11001
B. 110101 - 1010 B. 110101-1010
C. 101111-1100 C. 101111 -1100
D. 100101 + 1010 D. 100101+ 1010

66. is the number of bits ~ 66. —— U TS D Ade <o 99 §
in the internal databus of a processor. few &) W@ Bl © | O% ey & a8
It is also the number of bits a processor e A Bl 2, Rore Yums v R #
can process at a time, IR T a6l 8 |
A. Control Unit A. DT s@E (@B 9fe)

B. DataLength B. S o
C. Word Length C. 98 oI
D. AByte D. TP g

67. What determines the number of  67. [ T gRT uf Abs B < o
operations per second that a processor arell wifsaTedt Y T o FaRe s
can perform? It is expressed in g1 fosar siran 8 7 39 AmEes) (MHz)
megahertz (MHz) or gigahertz (GHz). 1 irmeEe (GHz) ¥ =k fdar ST 2
A. Clock Speed A TG We
B. Bandwidth B. =iy
C. Frequency C. amgfr
D. FLOPS D. T4 (FLOPS)

68. Which one of the following statements 68, MS-DOS @ Ir ¥ Fwfaiftaa § & $F
about MS-DOS is true? < BT W § ?

_ A. T8 Ud Gell O @i )
A. It is an open source software, HiwemT ¥
B. Itcan multitask. B. @ U w@m BT GHA B |
C. Ithasa Cnmmm‘ld Line Interface. C. s(:j;gw W}a E?R'ITIE it ﬁ'jﬂl
D. It supports multiusers. D. I8 UF Y e SudnTaart @
AL Far B
PA/AA 14 10110804114
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69. Which of the following statements

about kernels is INCORRECT?

A. Ttis a computer program that
coordinates all executing utilities.

B. Itis a computer program that
controls all computer operations.

C. Itis a computer program that
schedules and manages all system
processes.

D. Itis a computer program that
provides an interface between a
user and an operating system.

Pl B 9N Fefoiad ¥ ¥ B9 W

HYT AT & 7

A. T8 U1 SRR HARY (Ham) & 9
i Frefla Sudemarlt (gffeds)
B G BT & |

B. ug YT He¥ mARY () & @
i e el @ b s )

C. 48 Vul SR HARY (HmT) & &Y
Y gorelt wftrarslt @ Paife ik
Zaferd &l &

D. U8 T SR wHray ham) & &
IqARTER! 3R WHTR YU 3 4
Teh KRBT SUcTa e &

70. To create new volumes and format a 70. I arf—snY faeq 7 PN ¥ &Y
new disk that you just installed on a fovr Jerflg Gie) @  Sud Y
Windows 7 computer which tool would e (@) T o R @1 wwioe
you use? (ife) @ & forg My f=forfea #
3 o aEe (Ga) & wE wey ?

A. Disk Utility A. & gfefed @1

B. Format B. wfie @1

C. Disk Management C. & fmoiic &1

D. Disk Manager D. o MR @

71. The first generation of compulers used: 71. ugell 91 & FgeRl # Ll

wanT 5 s o)

A. vacuum tubes A. frdra sfererll @Rm o) &

B. transistors B. s (gifvreesd) &

C. semiconductors C. gDl &1

D. mechanical gears D. aify® st @

72. Which memory is NOT primarily based 72. frafafeg § @ @9 @ |y FN)
on semiconductors? %%1 w9 W A T R AR T
A. Main Memory g? .

B. Cache Memory o g5 Fﬂ%{ @qm -
C. Secondary Memaory g Wgﬁ%ﬁ?ﬁ}
D. Registers D. ey
10110804115 15 PA/AA
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73.

74.

3.

76.

Fiber relies on instead of
electricity to transmit data, which
facilitates much faster internet
connections that are capable of handling
higher bandwidth.

A. electricity B. light

C. electromagnetism D. magnetism

Which of the following cloud
infrastructure provisioned for exclusive
use by a single organisation comprising
multiple consumers (e.g., business
units). It may be owned, managed, and
operated by the organisation, a third
party, or some combination of them.
Private Cloud

Community Cloud

Public Cloud

Hybrid Cloud

oCOw>

What is common between Chrome,
Safari and Opera? They are all:

web browsers

search engines

social media sites

web services

o0 wp

ADSL provides data
rates in the downstream direction, from
the central office to the end user, than

73.

74.

¥ H

76.

32T HOR & forg wrgav fagga o e
— X foik A B, Y oif 9=
TR F 9 geHe GareE o et
HgM el /A & 9 9w defaey e
% e 2 §)

A. faEf B. WaTe
C. Rga—dasa D. 995

frfafag § & 59 oS s
g (TS SWRgdaY) § 3D
SRt are BT ved HeH
(STTERVI— IS SISl FRT 34
S9N YA 6 WEEHE & 7 ug e
Hra, WY 98 AT ST @ Ao gRT
Wifae W W, walba AR wafod fdar
T e ¥

A. fron Fares

B. WrEilis Twes

C. g9 FASe

D. HIR TGS

W, AEr 3R ART & 99 T T
a3 T € 7

A. 39 s (@9 o)

B. Wil 3o (w4 dfore)

C. ¥rre A e — we (WrEe)
D. a9 art

ADSL ————27 =¥ &1 aiftw warnr
¥ Fe0 F- WA a6 Iy e &
I FEE FE-WE I AW wg %

in the upstream direction, from the end T fRrem & W wer &

user to the central office.

A. higher A, TER

B. lower B. fA=aR

C. equal C. TR

D. higher or lower (depending upon D. S=er 1 R e oik Ser

provider and traffic) RO — IRATT ($f%®) T FAR)

PA/AA 10110804116
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77.

In web development, a is

39 R 3, — TH TER T 9 JTHT

a web application that combines (iiare) & Ol Ut Ao skrisas
multiple services to create a single new (Rerrer mfee sevww) # wef¥ o
service displayed in a single graphical 81 AT & oA B & g g wamsit
interface. B GRS B 2
A. Multicasting A. Heo! HwifteT
B. Moodle B. Heel
C. Meme C. 9
D. Mashup D. #eRM

78. The terms 'crawling’, 'indexing' and  78. ‘wiferr, ‘Sefda ik ¥hr v fbg
'ranking' are related to: gt g ?
A. phishing A. drEes (fBEm) &
B. searchengines B. @il g9 (|4 g &
C. browsers C. fagvai (e &
D. internet service providers D. Eei+c Hdl weramsll |

79. What is the keyboard shortcut to paste | 79. Microsoft word H13d ¥ faeuad a0
the contents of the clipboard in a aE B IRe B & foe fhe faEe
Microsoft Word file? Hidehe o WA fhar ST & ?
A Curl+P A. Cul+ P&l
B. Ctrl+V B. Ctrl +V &
C. Cul+C C. Cal + C1
D, Cul+X D. Ctrl+ X1

80. When entered in the cells of a Microsoft | 80. & Microsoft Excel a@¥iie $ varaf
Excel worksheet, numbers are, by (¥ow) # wod wfae 9 @ € A 9
default, g4 feiRa Refar (@8 fRwie) g/ ——

Bl §
A. leftaligned A. ¢ 3R R
B. centre aligned B. &g % wfdw
C. rightaligned C. < IR W
D. justified D. &q urdfy (GRewge)
10110804117 17 PhinA
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81. In Microsoft Word, you can customise 81. Microsoft Word ¥, &g
or choose predefined margin settings &1 T o gd FuiRe s
by going to el (o AfE) & sgafaa
(PecaTgy) B} aa & a1 g9 W 8|
A. Layout > Margins A. Layout> Margins
B. Insert > Margins B. Insert>Margins
C. Review > Margins C. Review >Margins
D. Draw > Margins D. Draw >Margins
82. In Microsoft PowerPoint 2016, 82, MS - PowerPoint 2016 #, 4
contains formatting, wWige W @ < el aW
positioning, and placeholder boxes for wafat & forg wifife, Qrefrafr
all of the content that appears on a slide. R = Eeex diew AT B &)
A. Outlineview  B. Slide format A. ASTARA . B. WgS BiAe
C. Slidelayout  D. Slide master C. 135S oiase D, WilEe AR
83. In MS-PowerPoint, 83. MS-PowerPoint ¥, IS
lets you copy all of the formatting from % v & gawr qwger (@feT) oy
one object and apply it to another one. PO T AR T TN e F wam
HR H TR S et # |
A. Format Style A. Bife wIET
B. FormatAll B. wiie sifd
C. Formal Paste C. Bifc ke
D. Format Painter | D. ®ife Yer
84. When' you're using . B4, v ¥ & AT W@
you'll always be running the most up- 8K &, T 39 Hag AdINiTe R WA
to-date version of the apps that B I wEifte R (audds) W
Microsoft can offer. This unlocks =T 8 B ¢ | a8 Pafia g srEHl
regular security updates, improvements (SruecH), R @ ude (3dl®) TRl
and more importantly, access to the g 3R aftr weagl w9 A/, 9w
latest features and tools as soon as they faftreart st T 9N € Sucer B
become available. € ISP SUH HRda &
A. Office 2019 A. Office 2019
B. Office 365 B. Office 365
C. Open Office C. Open Office
D. Cloud Office 2019 D. Cloud Office 2019
PAJAA . gt
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85. In Microsoft PowerPoint, you wantto | 85. MS-PowerPoint ¥ 37 78 g/ e
ensure that your company logo appears e & f6 amueh ol &1 vl e
on the right-hand top corner of all the (), =0 wew wgfiesm 4 Wl
slides in a given presentation. Which TESH B Hud a1 B R Rard ¥
of the following views would you use ¥ F P oy amuet At & 9
to do this? férer =g @ Syt TR B P
A. Slide Sorter A. ¥ligs Wi &

B. Slide Master B. W58 HAREY @
C. Notes Master C. FIcH ARER &
D. Outline View D. 3recargd & &l

86. To insert a table of contents in a 86. Microsoft Word 2016 gf-\ﬂ(s‘lagﬂa)
Microsoft Word 2016 document, you A gmfigt 1 afere wfae s &
would need to go to the fare sy A e Y
menu tab. BT |
A. Layout B. Design A. oRIST B. fumgw
C. References D. Insert C. IR D. s&¢

87. Inreference to Microsoft Excel, please 87. Microsoft Excel & &g #, Cao
see the contents of the following cells: =t vt () o wmidt 3

d r|e
6
8
Cell A3 has the formula =A1*3$A$2. A A3 71 53 = A1*$AS$2 & e
The formula from Cell A3 is copied to @) A3 ¥ 93 @ wee (@) B3 ¥
Cell B3. The value displayed in Cell B3 S 5 e &) v (@) Ba #
will be: yeffie =« @t 2 ?
A. 40 B. 20 A4 B. 20
e 2 Bis 49 C. 30 D. 48
10110804119 19 PA/AA
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88.

89.

is an established set of rules
that determine how data is transmitted
between different devices in the same
network. Essentially. it allows
connected devices to communicate
with each other, regardiess of any
differences in their internal processes,
structure or design.
A. Network Software
B. Network Protocol
C. Network Media
D. Network Operating System

A 1s a collection of

devices connected together in one
physical location, such as a building,
office or home. It can be small or large,

88. fredt &1 v wnfia wiE 8

89.

ot a7 PaifRa s & & @ & wora
(rea®) I faf= Suewil @ da e
® a9 vor yaifRa f&an o | afed
T W/, I8 Faifora SUEwo B |
HERY PR o &, W & 9! WaRke
siferaril, Tear ar sifeen (Fas=) &
P IR B

A. TdF HitedaR

B. “ca% Werad

C. eas e

D. -eas IARET Rrees

—— Hifte ®HE, WY "5,

PIITAT 7 &) ¥ T T S YD
Pl UH TUS 8| IF Ve AT 989 B
g & o v Ivdhrat & 9

ranging from a home network with one U & Wl (@9 Aead) W daN (P
user to an enterprise network with HETAa 7 e § g SyanTearet
thousands of users and devices in an 3R IuHUI F A IEH Farer
office or school. (Geos Acad) & Hahdl 8|
A. LAN B. WAN A. LAN B. WAN
C. MAN D. Cloud C. MAN D. Cloud
90. What is the full form of 'TCP'? 90. ‘TCP' &1 qof W&y o1 & ?
A. Transmission Carrier Package ‘ A. giafeE IR taw
B. Terminal Control Protocol B. cfiwa @gid Mewma
C. Transmission Control Protocol | C. giafT= soia Wedid
D. Transport Control Protocol D. giquid derd Hernie
91. Which one of the following devicesis | 91. ®R SUEicl § FYged o GG
used for connecting computers in a star ‘ e & fore frefrRea & g Susor
topology? &1 Wt fbar s 87
A. Hub B. Repeater A. &9 @1 B. Rz @
C. Bridge D. Router C. ot &1 D. ¥&ex &l
PA/AA 20 10110804120
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92. In whichtopology are all the network | 92. Fr=foRm & 9 fFw Ddel § i
nodes individually connected to a Hullel 9t (eas Agw) afdnma v
central switch, hub or computer that W @ &5 Raw, 4 a1 $9er 4§ g9
acts as a central point of &N & i w3nl ) uikg & & faw
communication to pass on the HeRVl & P herd &g &% w9 F o
messages? P 8§ ?

A. Star Topology A. R gt
B. Ring Topology B. f&r Mo
C. Bus Topology C. 99 aqiara
D. Hybrid Topology D. zEiis Jua

93. Aliyahas 2600 MB of data. Dineshhas | 93. anforar & Ui 2600 MB 37 21 R
4000 MB of data. The combined data | % U 4000 MB €T ¥| ¥ A W
would fitona USB flashdriveof T HYH WI H SR &
storage capacity. @ USB Tover 15a ¥ <1l off e &
A. 1GB B. 2GB A. 1GB B. 2GB
C. 6GB D. 10GB C. 6GB D. 10GB

94. Which of the following binary 94. f=fafeg % ¥ fra Remm) dfsm
operations would give 111010 as the (@1 sitave) & gRumT 111010 BRT?
result? (All numbers in this question are {39 v o W ey fRemmd e
in binary number system) ugfar (e Haw feew) 4 &)

A 111111 -1011 A. 111111- 1011
B. 100101 + 10101 B. 100101+ 10101
C. 110001 + 10101 C. 110001 + 10101
D. 111101-101 D. 111101-101

95. The is a small program that 95, ____ U& VSR & ag WuH 2
controls the computer from the time it W %ﬁ waﬁﬂ?mg ?‘;ﬁﬁ
powers on until the time the operating Tﬁa i it Rty
system takes over. s § 9 & 9
A. CMOS B. BIOS " Gl -

C. EPROM D. POST C. EPROM D. POST
10110804121 2|1 - PA/AA
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96.

What is the typical range of RAM size
in a standard laptop used for office
work?

A. 128KB-256 KB

B. 256 MB-512 MB

C. 4GB-16GB

D. 128 GB - 256 GB

96.

e & sm F wge fFy 9aF I
wes oivet # RAM % aar ot 9|
R 7 B 27

A. 128KB-256KB

B. 256 MB-512 MB

C. 4GB-16GB

D. 128 GB -256 GB

97. The part of the CPU which contains | 97. CPU @ @8 W fRrwd wfded w
circuitry that uses electrical signals to grar & 3R Y "uda st &y g
direct the entire computer system to T A Frafea 9 & fon @ eeger
carry out or execute stored program Rrew @1 FelRm &= & fog Rga
instructions is known as: Had BT AT B &, 99 fhw AW |

ST ST &7
A. control unit A. BEA gRIE
B. arithmetic and logical unit B. tRerfes alk wifrea g
C. ‘regaster C. ¥R
D. program counter D. 9 HrEeR

98. requires constant power  gg N B P T F
flow in order to function. Because of AR faagy smafd #) smavaaar Ted
the continuous power it doesn't need ¥ TR faggy o T Y ®
to be 'refreshed' to remember the data IR 3 F aiER HeRRd fFU o Ot
being stored. However, it is a volatile T AR W@ F fw I @
memory, which means that all the data HET U=aT & | Brdifh, U8 e aReR
that had been stored becomes lost once Y B 2 Rer af & ¥ wE AR
the power is cutoff. fregy oy ot B9 W 5w Weia

WRI ¥ I & W |
A. DRAM A. DRAM
B, 'SRAM B. SRAM
C. ‘S5DRAM C. SSDRAM
D. SDRAM D. SDRAM
PA/AA 22 10110804122
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99.

100.

A multitasking operating system means

A. multiple computers can be
networked together.

B. multiple people can use a computer
concurrently

C. several programs can be operated
concurrently

D. the operating system can divide
work between several CPUs

Which of the following statements is
NOT true with regard to the Auto Filter
option in Microsoft Excel?

A. By filtering information in a
worksheet, you can find values

99.

100.

Ao eIt it Ry =7 antf a8

g f

A. &% BYLRl BT (S WRI ead e
T qHdT |

B. &% I UF $HUCX B U A
RN &R HHhd & |

C. g 9 AuEl &1 UF | e
e o w@mar &

D. dfrfEn Rew, faff=1 CPUs &
dra & 31 forrfor &R g@ar &

Microsoft Excel # 3ifer fheex Reeq
& qau ¥ fFrafaRa § ¥ 39 91 a9
Wt 8 & ?

A. &8 aFdfic § gua o1 fheex
IR, I ged I B Slew WK

quickly. TN Hhd €|

B. You can set a filter on one column B. ¥ U% 994 ¥ €T & TP HieH
of data at a time, TR (F fheex A o) 9Fd £

C. You can control not only what you C. 3N 7 &gl 9 g o= woa &
want to see, but also what you want Y &g BT gEy § afew 9
to exclude. W) Ty A8 AT ey ¥ |

D. Youcan search for text and numbers D. 3y 3ifer fheex fadea &1 AT
using the Auto Filter option. T oo AR e G G &

10110804123 23 PA/AA
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Read the following instructions carefully:

Prafyfa Pdulzter 4 @ -

1. Qut of the four altematives for each question, only one circle
for the correct answer is to be darkened completely with
Black Ball Point Pen on the QMR Answer Sheel. The
answer once marked is not liable to be changed

2. The candidates should ensure that the Answer Sheet is not
folded. Do not make any stray marks on the Answer Sheet. Do
not write your Roll No. anywhere else except in the specified
space in the Answer Sheet

3. Handle the Test Booklet and Answer Sheet with care, as under
no crcumstances (except for disgepancy in Test Booklet),
another set will be provided.

4. The candidates will write the comrect Test Booklet Series as
given in the Test Booklet in the Attendance Sheet,

5. Each candldate must show on demand his / her Admit Card to
the Invigilator

6. No candidate, without special permission of the Center
Supenntendent or Invigilator, should leave his / her seat.

7. The candidates should not leave the Examination Hall without
handing over thew Answer Sheet to the Invigilator on duty
Cases where a candidate has not signed on the Attendance
Shest will be deemed not to have handed over the Answer
Sheet and dealt with as an unfair means case.

B. Use of Pencil/Electronic/Manual Calculator is prohibited.

9. The candidates are governed by all Rules and Regulations of
the Commission with regard to their conduct in the
Examination Hall. All cases of unfair means will be dealt with as
per Rules and Regulations of the Commission,

10. After Examination is owver, candidate has to retum his Answer
Sheet to invigilator, Imvigilator will hand over the Candidate’s
copy to candidate, then only andidate is allowed to leave the
examination hall, Candidate is only allowed to take Cancidate’s
copy of answer sheet

11. Candidates are not allowed to take Test Booklet with them.
They have to submit the Test Booklet to the Invigilator after

1. e iuRtm M AT AATham &
v 3t o1, 3R, IR e W HIA GE A F A gh
Y BT 1w uide 09§ W | U@ A I olfsa g
W & TG 98 FEE T o FE § |

2. whemdf gfie & 3 T s S EE T ey E Iy
W B o P A amd | ohenf s s
g was B P wum & aftfeam smm 3 fd

3. oy gfie @ T TEE S WEES W
TN forell +ff uiviRuy 3 (v wlten g Al
& ol ¢ ) gud ol g W@ awm o Suee
Tt O S |

4, e gt & 4 T i ofte dHw # Tl
o o lid R v § ol |

5. U0 T 9 W TR, S s @) S
i ey |

6. iy o oy o R o ¥ e g
el o wE T 81 |

7. FAiE TY HREF B AT I uAw B
ol s = e oved | af R wlemd 3
oS v3F W g T g | o arn s &)
IH I EF T e § AR 98 A A B
I S ST |

8. MR / e , roafte oiees & guim
afdfa g

9. wiian gfer & o & ferg wamdt amn & et el

v Rt g Frafe # (arfem wne! & wdt peelt
&1 Yraen amdm & Frow vl R & srEw dm)|

10. wian & Iwia sl I T By srlye B
2 1 rafiys T anadl 31 IR =T # el ufy
gt o v PO A Rred Ioia sy
Frate ot smfa f el | I @ A i ufa
sl Y e T A WP A ami

11, vhan & Jwia vhardf w ofan g sy
axwier =t derl oot Tl gRvm W

the mxam, wiamff g ary Ao wed ¥ |
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5 A 30 . A 55 B 80 C l
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QNO Ans aQnNo Ans QNO Ans Q NO Ans
1 D. 26 B 51 C 76 C

2 A 27 - C 52 C 77 C

3 B 78 A 53 C 78 B

4 D 29 C 54 D 79 A

5 C 30 B . 55 D 80 C

6 D 31 D 56 D 81 A

7 A 32 A 57 A 82 A

8 B 33 C 58 8 83 D

9 A 34 N 59 D 84 B

10 D 35 C 60 B 85 B

11 C 36 D 61 A 86 C

12 Full Marks 37 C 62 C 37 A
13 B .38 D 63 B 88 B

14 D 39 B 64 A 89 C

15 D. 40 B 65 A 90 B

16 D a1 A 66 A 91 B
17 C 42 B 67 D 92 B
18 c 43 B 68 B 93 A
19 A 44 D 69 B 94 D
20 D 45 C 70 C 95 B
21 C 46 c 71 A 96 C
22 D a7 B 72 C 97 A
23 Full Marks 48 D 73 D 98 C
24 D 49 A 74 B 99 5
25 A 50 A 75 B 100 C
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" QNO Ans QNO Ans QNO Ans Q NO Ans
1 C 26 D 51 A 76 A

2 E 27 A 52 A 77 A

3 A 28 B 53 C 78 "

4 D 29 C 54 C 79 B
5 D 30 A 55 = 80 B
6 A 31 C 56 D 81 C

7 B 32 B 57 D 82 A

8 D 33 D 58 D 83 B

9 - C 34 A 59 A 84 C
10 D 35 C 60 B 85 B
11 A 36 D 61 A 86 B
12 B 37 ¢ 62 D 87 B
13 A 38 D 63 B 88 A
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